
- 1 - 

 

 

 

 
 
 
 

Multisim v11 
Digital Primer 

 
to accompany 

 
Electricity: Principles and Applications 

Eighth Edition 
By Richard Fowler



- 2 - 

Introductions 
 

In an effort to help the reader understand the concepts presented in this textbook, key 

examples and problems will be presented through the use of computer simulation using 

Multisim.  Multisim is an interactive circuit simulation package that allows users to view 

their circuit in schematic form while measuring the various parameters of the circuit.  The 

ability to quickly create a schematic and then analyze the circuit through simulation 

makes Multisim a wonderful tool to help students understand the concepts covered in the 

study of electronics. 

 

This appendix will introduce the reader to the features of Multisim that directly relate to 

the study of dc, ac, and semiconductor electronics.  The following topics are covered: 

• Work Area  

• Opening a File 

• Running a Simulation  

• Saving a File 

• Components 

• Sources 

• Measurement Equipment 

• Circuit Examples 

• User Customization 

• Exporting Data to Excel 

• Adding Text and Graphics  
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A note on “mouse clicking”: The instruction click means pressing the left mouse button. 

A double-click means pressing the left mouse button twice. A right-click means pressing 

the right mouse button. 

 

Work Area 

The power of Multisim lies in its simplicity.  With just a few steps, a circuit can be either 

retrieved from disk or drawn from scratch and simulated.  The main screen, as shown in 

Figure 1, is divided into three areas: The menu bar (with its drop-down menus), the 

toolbars, and the work area.   

 

Figure 1  Main Screen 
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The menu bar gives the user access to all the functions of the program.  Initially, the user 

will only utilize a few menu selections.  Each drop-down menu is accessed by either 

clicking the menu name or by pressing the Alt key and the menu name’s underlined 

letter.  For example, to access the File menu, simply press Alt + F (holding down the Alt 

key while pressing the F key).  The File menu will drop down as shown in Figure 2. 

 

 
Figure 2  File Menu 
 
Initially, only two commands from the File menu need be mastered: opening a file and 

saving a file.  The remaining commands can be explored as time permits.   

 

The toolbars beneath the menu bar provide access to all the commands contained in the 

menus.  Typically, a user will access the commands through the toolbars instead of the 
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menu bar.  The most important icon in the assorted toolbars is the On-Off switch.  The 

On-Off switch starts and stops the simulation.  The push button next to the On-Off switch 

will pause the simulation.  Pressing the Pause button while the simulation is running 

allows the user to view a waveform or meter reading without the display changing.   

 

Opening a File 

The circuits referenced in this textbook are included on a compact disk located in the 

back of the textbook.  The files are divided into folders, one for each chapter.  The name 

of the file provides a wealth of information to the user.   

 

Example:  A typical file name would be Ch 3 Problems 3-1.  This first part of the file 

name tells the user that the file is located in the folder labeled Chapter 3.  The second 

part of the file name tells the user that it is question 1 out of the Problems section at the 

end of Chapter 3.    

 

To open a file, either click File on the menu bar and then click the Open command or 

click the open folder icon located on the toolbar (below the menu bar), as shown in 

Figure 3.  Both methods will cause the Open File dialog box shown in Figure 4 to pop 

open.  Navigate to the appropriate chapter folder and retrieve the file needed. 
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Figure 3  Opening a File 
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Figure 4  Open File Dialog Box 
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Running a Simulation 

The Multisim files developed for this textbook present the circuit in a standard format.  

The instrumentation is typically connected to the appropriate places within the circuit.  If 

the instrument’s display is not visible, double-click the instrument icon and the display 

will pop up.  There is a help screen referred to as the Description Box with information 

relating to the circuit and the instruments within the circuit.  This Description Box is 

opened by pressing Ctrl + D while in Multisim.   

 

The simulation can be started three ways: 

1. Selecting Simulate from the menu bar and then selecting Run. 

2. Pressing the F5 key. 

3. Clicking the toggle switch. 

 

All three ways are illustrated in Figure 5.  
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Figure 5  Starting the Simulation 
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Saving a File 

If the file has been modified, it needs to be saved under a new file name.  As shown in 

Figure 6, click File on the menu bar.  Then click the Save As command.  This will cause 

the Save As dialog box to open.  Give the file a new name, and click the Save button.  

The process is demonstrated in Figure 7. 

 

 

Figure 6  Save As Command 
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Figure 7  Save As Dialog Box 
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Components 

Multisim has two kinds of component models: those modeled after actual components 

and those modeled after “ideal” components.  Those modeled after ideal components are 

referred to as “virtual” components.  There is a broad selection of virtual components 

available, as shown in Figure 8. 

  

Figure 8  Virtual Component List 
 

The difference between the two types of components resides in their rated values.  The 

virtual components can have any of their parameters varied, whereas those modeled after 

actual components are limited to real-world values.  For example, a virtual resistor can 

have any value resistance and percentage tolerance, as shown in Figure 9. 
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Figure 9  Configuration Screen for a Virtual Resistor       
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Figure 10  Component Listing for Resistors 
 
 
The models of the actual resistors are available with tolerance values of 0, 0.1, 0.5, 1, 2, 

5, and 10 percent.  The same is true for all other components modeled after real 

components, as shown in Figure 10.  This is especially important when the 

semiconductor devices are used in a simulation.  Each of the models of actual 

semiconductors will function in accordance with their data sheets.  These components 

will be listed by their actual device number as identified by the manufacturers.  For 

example, a common diode is the 1N4001.  This diode, along with many others, can be 

found in the semiconductor library of actual components.  The parameters of the actual 

component libraries can also be modified, but that requires an extensive understanding of 

component modeling and is beyond the scope of this appendix.   
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If actual components are selected for a circuit to be simulated, the measured value may 

differ slightly from the calculated values, as the software will utilize the tolerances to 

vary the results.  If precise results are required, the virtual components can be set to 

specific values with a 0 percent tolerance. 

 

Two components require interaction with the user.  The switch is probably the most 

commonly used of these two devices.  The movement of the switch is triggered by 

pressing the key associated with each switch, as shown in Figure 11.  The key is selected 

while in the switch configuration screen, Figure 12.  If two switches are assigned the 

same key, they both will move when the key is pressed.  The DIP switch packs are 

available in two to ten switch configurations.  Each individual switch within the switch 

pack is activated by either pressing the associated key or by clicking it.  When the cursor 

is placed over an individual switch within a switch pack, a white rectangle appears 

around the switch and the cursor changes into a pointing hand symbol.  When the white 

rectangle is present and the cursor resembles a pointing hand, a single click will cause the 

switch to change positions.  The black dot on the switch pack signifies the ON position. 

 

Figure 11  Switches 
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Figure 12  Switch Configuration Screens 
 
 The second component that requires interaction with the user is the potentiometer.  The 

potentiometer will vary its resistance in predetermined steps with each key press.  The 

pressing of the associated letter on the keyboard will increase the resistance, whereas 

pressing the Shift key and the letter will decrease the resistance.  A slider located to the 

right of the potentiometer can also be used to adjust the resistance value by dragging it 

with the mouse.  As shown in Figure 13, the percent of the total resistance is displayed 

next to the potentiometer.  The incremental increase or decrease of resistance is set by the 

user on the configuration screen.  The associated key is also set in the configuration 

screen, as shown in Figure 14. 
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Figure 13  Potentiometer 
 
 
 

       

Figure 14  Potentiometer Configuration Screen 
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Sources 
In the study of dc and ac electronics, the majority of the circuits include either a voltage 

or current source.  There are two main types of voltage sources: dc and ac sources.  The 

dc source can be represented two ways: as a battery (in Figure 15) and as a voltage 

supply.      

 

Figure 15  DC Source as a Battery 
 

The voltage rating is fully adjustable.  The default value is 12 V dc.  If the component is 

double-clicked, the configuration screen shown in Figure 16 will pop up and the voltage 

value can be changed. 
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Figure 16  Configuration Screen for the DC Source  
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The voltage supplies are used in semiconductor circuits to represent either a positive or 

negative voltage supply.  Figure 17 contains the VCC voltage supply used in transistor 

circuits.  Field-effect transistor (FET) circuits will utilize the VDD voltage supply as 

illustrated in Figure 18.   

                                      

Figure 17  VCC Voltage Source                 Figure 18  VDD Voltage Source 
     

 

Figure 19 depicts the +VCC and the –VEE voltage sources.  These sources are found in 

operational amplifier (op-amp) circuits.  Operational amplifiers typically have two 

voltage supplies: a negative (VEE) and a positive (VCC) voltage supply, as shown in Figure 

20. 

                               

Figure 19  VCC and VEE Voltage Sources                    Figure 20  VCC and VEE Op-Amp Example                     
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The voltage rating is fully adjustable for all three voltage sources.  The default value is 

+5 V dc for VCC and VDD.  The default value for VEE is –5 V dc.  If the component is 

double-clicked, the configuration screen shown in Figure 21 will pop up and the voltage 

value can be changed. 

 
Figure 21  VDD Configuration Screen 
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The ac source can be represented as either a schematic symbol or a function generator.   

The schematic symbol for an ac source can represent either a power source or a signal 

voltage source.  The amplitude of the power source will be in VRMS, whereas the 

amplitude of the signal voltage source will be in VP. 

 

The schematic symbols for the two ac sources, as shown in Figure 22, will include 

information about the ac source.  This information will include the device reference 

number, VRMS value or VP value, frequency, and phase shift.  These values are fully 

adjustable.  The default values for the two sources are shown in Figure 23.  If the 

component is double-clicked, the configuration screen will pop up and the value can be 

changed. 

 

                           

Figure  22  AC Sources    
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 Figure 23  Configuration Screens for the Two AC Sources     
 

Multisim provides two function generators: the generic model and the Agilent model.  

The Agilent model 33120A has the same functionality as the actual Agilent function 

generator. 

 

The generic function generator icon is shown in Figure 24, along with the configuration 

screen.  The configuration screen is displayed when the function generator icon is 

doubled-clicked.  The generic function generator can produce three types of waveforms: 

sinusoidal wave, triangular wave, and a square wave.  The frequency, duty cycle, 

amplitude, and dc offset are all fully adjustable. 



- 24 - 

 

 

Figure 24  Generic Function Generator and Configuration Screen 
 

 

The Agilent function generator is controlled via the front panel, as shown in Figure 25.  

The buttons are “pushed” by clicking.  The dial can be turned by dragging the mouse 

over it or by placing the cursor over it and spinning the mouse wheel.  The latter is by far 

the preferred method. 

 

 

Figure 25  Agilent Function Generator 
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There are two types of current sources: dc and ac sources.  The dc current source is 

represented as a circle with an upward pointing arrow in it.  The arrow in Figure 26 

represents the direction of current flow.  The arrow can be pointed downward by rotating 

the symbol 180 degrees.       

 

Figure 26  DC Current Source 
 
The current rating is fully adjustable.  The default value is 1 A.  If the component is 

double-clicked, the configuration screen in Figure 27 will pop up and the current value 

can be changed. 

 

Figure 27  DC Current Source Configuration Screen 
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The ac current source is represented as a circle with a upward pointing arrow.  There is a 

sine wave across the arrow.  The schematic symbol in Figure 28 will include information 

about the ac current source.  This information will include the device reference number, 

Ipeak value, frequency, and phase shift.  These values are fully adjustable.  The default 

values are shown in Figure 29.  If the component is double-clicked, the configuration 

screen will pop up and the values can be changed. 

                     

Figure 28  AC       Figure 29  AC Current Source Configuration Screen                                    
Current Source 
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Multisim requires a ground to be present in the circuit in order for the simulation to 

function properly.  The circuit must contain a ground, and all instrumentation must have a 

ground connection.  The schematic symbol for ground is shown in Figure 30. 

 

     
Figure 30  Ground          
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Measurement Equipment 

Multisim provides a wide assortment of measurement equipment.  In the study of dc, ac, 

and semiconductor electronics, the three main pieces of measurement equipment are the 

digital multimeter, the oscilloscope, and the Bode plotter.  The first two pieces of 

equipment are found in test labs across the world.  The Bode plotter is a virtual device 

that automates the task of plotting output voltage versus frequency.  This is usually done 

by taking many measurements and plotting the results in a spreadsheet.  The Bode plotter 

automates this time-consuming process. 

 

Multimeters 

There are two multimeters to choose from: The generic multimeter and the Agilent 

multimeter.  The generic multimeter will measure current, voltage, resistance, and 

decibels.  The meter can be used for both dc and ac measurements.  The different 

functions of the meter are selected by clicking the icon to the left in Figure 31.  Clicking 

will cause the multimeter display to pop up.  The different functions on the display can be 

selected “pushing” the different buttons via clicking. 

 

 

Figure 31  Generic Multimeter Icon and Configuration Screen 
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The Agilent multimeter icon and meter display are shown in Figure 32.  The display is 

brought up by clicking the Agilent multimeter icon.  This multimeter has the same 

functionality as the actual Agilent multimeter.  The different functions are accessed by 

“pushing” the buttons.  This is accomplished by clicking a button.  The input jacks on the 

right side of the meter display correspond to the five inputs on the icon.  If something is 

connected to the icon, the associated jacks on the display will have a white “X” in them 

to show a connection. 

 

Figure 32  Agilent Multimeter Icon and Meter Display 
 

 

Oscilloscopes 

There are three oscilloscopes to choose from: The generic oscilloscope, the Agilent 

oscilloscope, and the Tektronix oscilloscope.  The generic oscilloscope shown in Figure 
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33 is a dual-channel oscilloscope.  The oscilloscope display is brought up by clicking the 

oscilloscope icon.  The settings can be changed by clicking each box and bringing up the 

scroll arrows.  The color of the traces will match the color of the wire segments 

connecting the oscilloscope to the circuit.  To change the color of the trace, right-click the 

wire segment connecting the oscilloscope to the circuit and then select Color Segment 

from the pop-up box.  Select the color for the wire segment and corresponding trace from 

the color palette.  

 

 

 

Figure 33  Generic Oscilloscope Icon and Oscilloscope Display 
 
 

The Agilent oscilloscope icon in Figure 34 has all the functionality of the model 54622D 

dual-channel oscilloscope.  The Agilent oscilloscope is controlled via the front panel, as 
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shown in Figure 35.  The buttons are “pushed” by clicking.  The dials can be turned by 

dragging the mouse over it or by placing the cursor over it and spinning the mouse wheel.  

The latter is the preferred method. 

 
 
 

 
Figure 34  Agilent Oscilloscope Icon 
 
 

 
Figure 35  Agilent Oscilloscope Display 
 
 

The Tektronix oscilloscope icon shown in Figure 36 has all the functionality of the model 

TDS2024 four-channel digital storage oscilloscope.  The color of the four channels is the 

same as the channel selection buttons on the display: yellow, blue, purple, and green for 
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channels 1 through 4, respectively.  The Tektronix oscilloscope is controlled via the front 

panel as seen in Figure 37.  The buttons are “pushed” by clicking.  The dials can be 

turned by dragging the mouse over it or by placing the cursor over it and spinning the 

mouse wheel.  The latter is the preferred method. 

 
 

 
Figure 36  Tektronix Oscilloscope Icon 
 
 

 
Figure 37  Tektronix Oscilloscope Display 
 
 

 

Voltage and Current Meters 

Multisim provides simple voltmeters and ammeters, as shown in Figure 38, for use when 

voltage or current need to be measured.  These meters can be placed throughout the 
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circuit.  The meters are available in both vertical and horizontal orientation to match the 

layout of the circuit.  The default is dc.  If the meters are to be used for ac measurement, 

then the configuration screen shown in Figure 39 must be opened and that parameter 

changed to reflect ac measurement.  To open the configuration screen, double-click the 

meter. 
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Figure 38  Voltage and Current Meters         
 

               
Figure 39  Voltmeter Configuration Screen         
 
 
 
Bode Plotter 
 
The Bode plotter is used to view the frequency response of a circuit.  In the actual lab 

setting, the circuit would be operated at a base frequency and the output of the circuit 
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measured.  The frequency would be incremented by a fixed amount and the measurement 

repeated.  After operating the circuit at a sufficient number of incremental frequencies, 

the data would be graphed, with independent variable “frequency” on the x axis and 

dependant variable “amplitude” on the y axis.  This process can be very time-consuming.  

Multisim provides a simpler method of determining the frequency response of a circuit 

through the use of the virtual Bode plotter. 

 

In Figure 40, the positive terminal of the input is connected to the applied signal source.  

The positive terminal of the output is connected to the output voltage of the circuit.  The 

other two terminals are connected to ground.  The value of the ac source does not matter; 

the ac source just needs to be in the circuit.  The Bode plotter will provide the input 

signal. 

 

 
Figure 40  Bode Plotter 
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Figure 41  Bode Plotter Display 
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Circuit Examples 
 
 
Example 1  Voltage measurement using a voltmeter in a series dc circuit. 

 

A voltmeter in Figure 42 is placed in parallel with the resistor to measure the voltage 

across it.  The default is set for dc measurement.  If ac is required, double-click the meter 

to bring up the configuration screen.  All circuits must have a ground.  Figure 43 contains 

a Quick Hint on the use of the voltmeter. 

 

 
Figure 42  DC Voltage Measurement with a Voltmeter 
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Figure 43  Voltmeter Quick Hint 
 
 
Example 2  Voltage measurement using a generic multimeter in a series dc circuit. 
 
 

A generic multimeter is placed in parallel with the resistor to measure the voltage across 

it.  Be sure to double-click the generic multimeter icon to bring up the meter display as 

shown in Figure 44.  Press the appropriate buttons for voltage and then dc or ac 

measurement.  All circuits must have a ground.  Figure 45 contains a Quick Hint on the 

use of the generic multimeter. 
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Figure 44  DC Voltage Measurement with a Generic Multimeter 
 

 
Figure 45  Generic Multimeter Quick Hint 
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Example 3  Voltage measurement using an Agilent multimeter in a series dc circuit. 

 

In Figure 46, an Agilent multimeter is placed in parallel with the resistor to measure the 

voltage across it.  Be sure to double click the Agilent multimeter icon to bring up the 

meter display.  Press the appropriate buttons for voltage and then dc or ac measurement.  

All circuits must have a ground.  Note the two white circles and black X’s on the right 

side of the display to indicate a connection to the meter.  Note:  This instrument requires 

that its power button be pressed to “turn on” the meter.  Figure 47 contains a Quick Hint 

on the use of the Agilent multimeter. 
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Figure 46  DC Voltage Measurement with an Agilent Multimeter 
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Figure 47  Agilent Multimeter Quick Hint 
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Example 4  Current measurement using an ammeter in a series dc circuit. 

 

In Figure 48, an ammeter is placed in series with the resistor and dc source to measure the 

current flowing through the circuit.  The default is set for dc measurement.  If ac is 

required, double-click the meter to bring up the configuration screen.  All circuits must 

have a ground.  Figure 49 contains a Quick Hint on the use of the ammeter. 

 
Figure 48  DC Current Measurement with an Ammeter 
 
 

     
Figure 49  Ammeter Quick Hint 
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Example 5  Current measurement using a generic multimeter in a series dc circuit. 

 

In Figure 50, a generic multimeter is placed in series with the resistor and dc source to 

measure the current flowing through the circuit.  Be sure to double-click the generic 

multimeter icon to bring up the meter display.  The current function is selected by 

clicking on the “A” on the meter display.  Since the source is dc, the dc function of the 

meter is also selected, as indicated by the depressed button.  All circuits must have a 

ground.  Figure 51 contains a Quick Hint on the use of the generic multimeter. 

 

 
Figure 50  DC Current Measurement with a Generic Multimeter 
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Figure 51  Generic Multimeter Quick Hint 
 

 

Example 6  Current measurement using an Agilent multimeter in a series dc circuit. 

 

In Figure 52, an Agilent multimeter is placed in series with the resistor and source to 

measure the current flowing through the circuit.  Be sure to double-click the Agilent 

multimeter icon to bring up the meter display.  Selection of dc current measurement is the 

second function of the dc voltage measurement button.  Be sure to press the Shift button 

to access the second function of the voltage button.  Note the two white circles and black 

X’s on the right side of the display to indicate a connection to the meter.  All circuits 

must have a ground.   
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This instrument requires that its power button be pressed to “turn on” the meter.  Figure 

53 contains a Quick Hint on the use of the Agilent multimeter for current measurement. 

 
Figure 52  DC Current Measurement with an Agilent Multimeter 
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Figure 53  Agilent Multimeter Quick Hint for Current Measurement 
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Example 7  Voltage measurement using a generic oscilloscope in a series ac circuit. 
 
 

In Figure 54, channel 1 of the generic oscilloscope is connected to the positive side of the 

resistor.  The ground connection of the scope and the circuit must be grounded.  The 

oscilloscope will use the ground as a reference point.  This generic oscilloscope’s 

operation follows that of an actual oscilloscope. The oscilloscope display is brought up 

by clicking the oscilloscope icon.  The settings can be changed by clicking in each box 

and bringing up the scroll arrows.  Adjust the volts per division on the channel under 

measurement until the amplitude of the waveform fills the majority of the screen.   Adjust 

the Timebase such that a complete cycle or two are displayed.  Figures 55, 56, and 57 

contain Quick Hints on the use of the generic oscilloscope. 

 
  

 
Figure 54  Voltage Measurement with a Generic Oscilloscope 
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Figure 55  Generic Oscilloscope Icon Quick Hint 
 
 

 
Figure 56  Generic Oscilloscope Quick Hint 



- 50 - 

 
Figure 57  Generic Oscilloscope Quick Hint 
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Example 8  Voltage measurement using the Agilent oscilloscope in a series ac circuit. 
 
 

In Figure 58, channel 1 of the Agilent oscilloscope is connected to the positive side of the 

resistor.  The ground connection of the scope and the circuit must be grounded.  The 

oscilloscope will use this ground as a reference point.  This Agilent oscilloscope’s 

operation follows that of a dual-channel, +16 logic channel, 100-MHz bandwidth Agilent 

model 54622D oscilloscope.  The oscilloscope display, as shown in Figure 59, is brought 

up by clicking the oscilloscope icon.  The settings can be changed by placing the mouse 

over the dials and spinning the mouse wheel or by “pressing” the buttons with a click.  

Adjust the volts per division on the channel under measurement until the amplitude of the 

waveform fills the majority of the screen.   Adjust the Timebase in the Horizontal section 

such that a complete cycle or two are displayed.  This instrument requires that its power 

button be pressed to “turn on” the oscilloscope.  Figures 60, 61, and 62 contain Quick 

Hints on the use of the Agilent oscilloscope. 
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Figure 58  Voltage Measurement with an Agilent Oscilloscope 
 
 

 
Figure 59  Agilent Oscilloscope Display 
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Figure 60  Agilent Oscilloscope Icon Quick Hint 
 
 

 
Figure 61  Agilent Oscilloscope Quick Hint 
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Figure 62  Agilent Oscilloscope Quick Hint 
 
 



- 55 - 

Example 9  Frequency and voltage measurement using the Tektronix oscilloscope in 
a series ac circuit. 
 
 

In Figure 63, channel 1 of the Tektronix oscilloscope is connected to the positive side of 

the resistor.  The ground connection of the scope and the circuit must be grounded.  The 

oscilloscope will use this ground as a reference point. The Tektronix oscilloscope has all 

of the functionality of the model TDS2024 four-channel digital storage oscilloscope. The 

oscilloscope display is brought up by clicking the oscilloscope icon.  The settings can be 

changed by placing the mouse over the dials and spinning the mouse wheel or by clicking 

the buttons.  Adjust the volts per division on the channel under measurement until the 

amplitude of the waveform fills the majority of the screen.   Adjust the Timebase in the 

Horizontal section such that a complete cycle or two of the waveform is displayed.  This 

instrument requires that its power button be pressed to “turn on” the oscilloscope.  The 

voltage and frequency can be measured by the user or by using the Measure function of 

the oscilloscope.   
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Figure 63  Voltage and Frequency Measurement with a Tektronix Oscilloscope 
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Figure 64  Measurement of the Period of the Waveform 
 
Using volts per division and the seconds per division settings, the amplitude and 

frequency of the waveform in Figure 64 can be determined.  The amplitude of the 

waveform is two divisions above zero volts.  (The yellow arrow points to the zero 

reference point.)  The volts per division setting is set to 500 mV per division. 

 

Vp = 1 V 

 

Vp-p = 2 V 

 
 
 
 
The period of the waveform is measured to be 1 ms.  Since frequency is the reciprocal of 

the period, the frequency can be calculated. 
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The Tektronix oscilloscope can also perform the voltage and frequency measurements 

automatically through the use of the Measure function.  The four steps and the resulting 

display are shown in Figures 65 and 66.  To set up the oscilloscope to measure these 

values automatically: 

 

1. Press the Measure button. 

2. Select the channel to be measured. 

3. Select what is to be measured: Vp-p, frequency, etc. 

4. Return to the main screen. 

5. Repeat for other channels and or values. 
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Figure 65  Tektronix Oscilloscope Measurement Function Setup 
 

 
Figure 66  Tektronix Oscilloscope Measurement Display 
 
 

Figures 67, 68, and 69 contain Quick Hints on the use of the Tektronix oscilloscope. 
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Figure 67  Tektronix Oscilloscope Icon Quick Hint 

 
Figure 68  Tektronix Oscilloscope Quick Hint 
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Figure 69  Tektronix Oscilloscope Quick Hint 
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User Customization 
 
There are several changes to the base configuration of Multisim that will make it easier 

for you to use.  Multisim uses a grid system to align the various components in the work 

area.  When the program is first installed, the grid will be visible in the work area.  It will 

appear as a pattern of dots, as shown in Figure 70.  

 

 
 
Figure 70  The Work Area with the Grid Displayed 
 
The grid pattern can be turned off in the Sheet Properties submenu of the Options menu.  

The grid will still be used to align the components; however, the dots will not be visible.  
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To access the Sheet Properties submenu, either press Alt + O or click Options on the 

menu bar, as shown in Figure 71. 

 
Figure 71  Access to the Sheet Properties Submenu 

 

The Sheet Properties submenu shown in Figure 72 will allow the user to control the work 

area environment.  The Workspace tab gives the user access to the grid controls, the sheet 

size, and orientation. 
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Figure 72  Workspace Tab of the Sheet Properties Submenu 

 

The initial configuration of Multisim will display the Net Names within the circuit.  The 

Net Names are the numbers circled in red in Figure 73. 

 

Figure 73  Net Names Displayed 
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If the Net Names are a distraction, they can be turned off from within the Circuit tab of 

the Sheet Properties submenu, as shown in Figure 74.  In addition to controlling the 

display of the Net Names, this tab gives the user access to which component parameters 

are displayed at the global level and the color of the various components and wiring.  A 

custom color scheme can be defined on this screen as well. 

 

Figure 74  The Circuit Tab of the Sheet Properties Submenu 
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Exporting Data to Excel 

The Bode plotter and the oscilloscope were introduced in the section, “Measurement 

Equipment.”  Although the displays of the Bode plotter and the oscilloscope are quite 

informative, it may be useful to have the data in numerical form for further analysis.  

After the Bode plotter simulation is run or a waveform is viewed on the oscilloscope, the 

data can be viewed in the Grapher.  The command to initiate Grapher is on the View 

menu.  To access the View menu, either press Alt + V or click View in the menu bar, as 

shown in Figure 75. 

 

Figure 75  Accessing the Grapher via the View Menu 
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If Excel is also loaded on the computer, the data used to generate the plot in the Grapher 

can be exported to an Excel worksheet for further analysis.  The plot to be exported must 

be selected by clicking it.   The red indicator arrow on the Grapher screen, as shown in 

Figure 76, points to the plot to be exported.   

 

 

Figure 76  The Grapher  
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Once the plot is selected, the data can be exported to an Excel worksheet by clicking the 

Excel icon in the upper right-hand side of the toolbar, as shown in Figure 76.  The export 

feature will create a new worksheet with the x and y data in adjacent columns.  Data from 

the generic oscilloscope were captured by the Grapher in Figure 77. 

 

Figure 77 Exporting Oscilloscope Data to Excel 

After the export to Excel icon is clicked, Multisim will prompt the user for the desired 

trace to be exported, as shown in Figure 78.  As part of the export process, Excel will be 

started, and a new worksheet will be created with the data from the x axis in column A 

and the data from the y axis in column B.  The data used to create the waveform within 

Multisim can now be examined using the analytical capabilities of Excel. 
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Figure 78  Selecting the Trace for Export 

 

Figure 79  Creating a New Excel Worksheet 

 

 

Figure 80  The Excel Worksheet with Exported Data 
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Adding Text and Graphics 
 
Simply constructing the circuit and running the simulation are only part of the overall 

process.  It is also very important to create circuits that include information that clearly 

explains what is taking place.  Both annotation and graphics can be added to a circuit 

schematic to aid in the understanding of it by the viewer.  To add text to the work area, 

either press Ctrl + Alt + A or click Place on the menu bar, as shown in Figure 81.  Move 

the cursor to the location within the work area where the text should begin, and click 

once.  To exit the “text edit” mode after the text has been entered, click anywhere else on 

the work area.  The text can be edited by double-clicking the text.   The text can be 

repositioned in the work area by placing the cursor over the text, holding down the left 

mouse button, and dragging the text its new location. 
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Figure 81 Placing Text in the Work Area 

 

Basic drawing tools are available to annotate the work area.  The option to import a 

picture into the work area is also accessible from the Graphics dialog box.  As shown in 

Figure 82, click Place, which is located on the menu bar.  Then select Graphics from the 

drop-down menu.  This will cause the Graphics dialog box to open.  The default file 

format for pictures to be inserted into the drawing is bitmap (.bmp). 
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Figure 82 Placing Graphics in the Work Area 

 

Once the lines or shapes are drawn, they can be modified or repositioned.  A right-click 

on a line or shape will cause the edit menu to open as shown in Figure 83.  The properties 

of the object can be changed in the edit menu.  The line or shape can be repositioned by 

placing the cursor over the object and holding the left mouse button down while it is 

dragged to its new location.   
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Figure 83 Modifying Graphics in the Work Area  

 

The text and graphics tools within Multisim provide the ability to add graphics and text to 

the work area.  This feature enhances the readability of the schematic, especially when it 

is going to be used in a laboratory report.  Figure 84 provides an example of an annotated 

schematic that could be used within a laboratory report.  Notice how the addition of the 

color, text, and graphics helps document what is being measured within the circuit.  
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Figure 84 The Use of Annotation and Graphics in the Work Area  

 

Conclusion 

 
Multisim is an interactive circuit simulation package that allows users to view their 

circuit in schematic form while measuring the various parameters of the circuit.  The 

ability to create a schematic quickly and then analyze the circuit through simulation 

makes Multisim a wonderful tool for students studying the concepts covered in this 

textbook. 

 


